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LEGAL NOTICE 

 

© 2003 by SmartTrack Ltd., United Kingdom. 

Parts of these materials may be the property of other copyright holders, permission from whom 
has been sought by SmartTrack for the production of these materials. 

Such permission of reproduction and modification is NOT implicitly given to the users or 
customers of these materials.   

 
This material is copyrighted and all rights are reserved to SmartTrack Ltd., and other respective 
copyright owners.  No part of this publication may be reproduced, transmitted, transcribed, 
stored in a retrieval system, or translated into any language or computer language, in any form 
or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, 
without the prior written permission of the owners of the copyrights. 
 

The creators, suppliers and copyright holders of this material make a sincere effort to ensure the 
accuracy of the material described herein; however, they make no warranty, express or implied, 
with respect to the quality, correctness, reliability, accuracy, or freedom from error of this material 
or the products it describes. Data used in examples and sample data files are intended to be 
fictional. Any resemblance to real persons or companies is entirely coincidental. 
 
The names of software products referred to in this manual are claimed as trademarks of their 
respective companies.  
 
SmartLearnTM  is a registered trademark of SmartTrack Ltd. 
 
vLearningTM is a registered trademark of SmartTrack Ltd. 
 
SmartTrackTM is a registered trademark of SmartTrack Ltd. 
 
MicrosoftTM is a registered trademark of Microsoft, Inc. 
 

© 2003 by SmartTrack Ltd., United Kingdom. 
 

© 2003 by VBL Systems Ltd., United Kingdom 
 
 
The customer may not : 
 
Edit or modify any of the courseware in any way whatsoever.   
 
Allow the materials to be used by any persons other than those for whom a usage licence fee or 
pay-per-view charge has been paid to SmartTrack Ltd. 
 
Allow the materials to be copied onto removable media and the materials may not be transferred 
to any other persons or party using any means whatsoever including but not restricted to email, 
file transfers or hard drive copy. 
 
Resell or re-license electronic, magnetic or printed versions of any SmartLearn content (either 
original or modified). 
 
Translate, modify or create derivative work of the product (SmartLearn system and/or content) or 
attempt to create a product that is visually or functionally similar to the product. 
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LIMITATION OF LIABILITY 
 
SmartTrack does not warrantee that the Product will meet the Customer’s requirements, or will 
operate in combination with other programs that the Customer selects, or that the operation of 
the Product will be uninterrupted or error-free. 
 
SmartTrack will not be liable for any indirect, special or consequential damages related to or 
arising out of this agreement, including, but not limited to, damages for lost data, downtime, lost 
goodwill, or lost business, even if the customer has notified SmartTrack of the possibility of such 
damages.  
 
TERMS OF USAGE 
 
The Customer may not sublicense, assign, delegate, or otherwise transfer the Product, or any of 
the Customer’s rights or obligations under this Agreement, to any non-affiliated third party 
without our prior written approval, which approval shall not be unreasonably withheld.  The 
Customer may assign this Agreement, and the Customer’s rights hereunder, to an affiliated 
corporation, provided that the Customer notifies SmartTrack in advance, in writing of such 
assignment, all copies of the Product provided to or made by the Customer are either transferred 
to the assignee or destroyed, and the assignee agrees in writing to all of the terms and 
conditions of this Agreement.  For the purpose of this Agreement, an ‘affiliated’ party means any 
third party controlling, controlled by or under common control with, the Customer. 
 
OTHER 
 
The Customer acknowledges that the Product is protected by UK, United States and 
International copyright laws and international treaty provisions and that all right, title and interest 
in and to the Product is, and remains in, SmartTrack and its licensors, except for the right to use 
the Product in accordance with the Customer Licence Agreement.  SmartTrack and its affiliates 
retain all rights not expressly granted, including all rights pertaining to their names and 
trademarks.  Nothing in this License Agreement constitutes a waiver of SmartTrack’s rights 
under UK, USA and International   copyright laws or any other laws or international treaty. 
 
By reading, printing or viewing this document, the Customer and end user understands 
and agrees that : 
 

1. the material may be used to provide training at a single designated site, such as a 
training centre, school, or corporate address. 

 
2. under no circumstances may any files contained in the training materials be made 

available on a network, internet, intranet, CD-ROM, DVD, or similar medium. 
 

3. the training material must not be re-sold, rented, assigned or transferred to any third 
party in any form. 

 
4. they are licensed to use the training material until the license term and that they must 

renew their license after this date in order to continue using the training material. If the 
licence is not renewed, all instances of the materials, in all forms, must be removed 
and/or destroyed within 5 days of the end of the licence term. 

 
5. the copyright remains with the copyright holders and that under no circumstances may 

any copyright notices be removed. 
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2 About This Course 
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2.1 Who Is It For and How Do I Use 
It? 

2.1.1 Who Is It For? 
This manual is designed for use with the ECDL - Information and Network Services course with 
SmartLearn. 
 
It is not meant as a replacement to the full reference manuals that come with Internet Explorer or 
Outlook.  

2.1.2 How Should I Use it? 
This manual is a step by step guide to the functions taught in the ECDL - Information and 
Network Services course. 
 
You should be able to find the part you’re after by looking in the index and contents, and noting 
that the general course will follow the pattern of the manual. 
 
The step by step parts are in italics. Simply do the things on the left, and read the things on the 
right for further information. 
 

This is what you do This is a description of what is happening 
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2.2 What Do the Icons Mean? 
 

Tips 

Handy tips that make your work easier 

 
 

Essential 

Essential points to understand how to do the work in hand 

 
 

Technical 

Technical (non essential) points for the technically minded 

 
 

Traps 

Hints to help you with certain features that may just trip you up if you are not 
aware of them! 

 
 

Right Mouse Button 

This means that pressing the right mouse button (instead of the left mouse 
button) will bring up a shortcut menu that can achieve the same things as listed 

in the text 
 

You can also
use the right
mouse
button here

 

 
 
 
 
 



ECDL - Information and Network Services - About This Course 

Page 8 SmartTrack  - 0800 358 0 458 

2.3 Working with Windows 

2.3.1 What Are Windows? 
Every task that you perform on your computer will open in a box called a window. For instance, 
when you open Word, a window appears on the screen containing the software. You then work 
inside the window. 
 
It is possible to have many windows open at once. Our online courses require you to have at 
least two windows open… 
 
• Internet Browser (e.g. Internet Explorer, Netscape Navigator), which contains course 

lessons 
• The software you are learning, e.g. Word, Excel, Outlook 

2.3.2 The Elements of Windows 

Title Bar 

Menu Bar 

Toolbar 

Close 

Maximise/Restore 
Minimise 
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2.3.3 Minimising Windows 
Minimising a window makes it temporarily disappear! Use it if you have to get a window out of 
the way so you can see something else! 
 

Click minimise at the top right of the window 
 
 
To restore a window after it has been minimised… 
 

Click the name of the window from the task bar at the bottom of the screen  
 

 

2.3.4 Maximising/Restoring Windows 
Maximise allows you to make a window fill the whole of the screen. Use it when you want to 
concentrate on just one window.  
Maximise is interchangeable with restore. When you restore a window it is still visible, but will not 
fill the whole screen. You can change the restored shape to anything you want by resizing the 
window (see below). 
 
Maximising a Window… 
 

Click Maximise at the top right of the window  The window will fill the screen 
The Maximise button will change to the 
Restore button   

 
Restoring a Window… 
 

Click Restore at the top right of the window   The window will shrink 
The Restore button will change to the 
Maximise button   

2.3.5 Closing Windows 
Click the X at the top right of the window   

2.3.6 Switching Between Windows 
Click the window you require on the task bar to make the window appear on the screen 
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2.3.7 Resizing Windows 
1. Ensure that the window is restored If the window is minimised or 

maximised you can't resize it! 
2. Position the mouse at the edge of a 

window 
The mouse pointer will change to a 
double-headed arrow 

3. Click and drag to resize the window  
  

 

2.3.8 Moving Windows 
1. Ensure that the window is restored If the window is minimised or 

maximised you can't move it 
2. Position the mouse on the blue title bar The mouse pointer will change to 

a white arrow 
3. Click and drag to move the window to a 

new position 
 

 

 
 
 

The window for Word is 
overlapping the browser 
window. If you position your 
mouse at this edge and click 
and drag to the left, you will 
make the window narrower, 
and get rid of the overlap.  
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3 Getting Started On 
The Web 
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3.1 Understanding the Web 

3.1.1 The Internet and WWW 
The internet is basically all the millions of computers around the world that are connected 
together. Each computer can communicate with another one, as long as they are connected to 
the internet.  
 
The world wide web, or web, or www, is the method that the computers use to access 
information on the internet. 

3.1.2 Web Browsers 
A web browser is a program that lets you look at webpages and web sites. Some common 
browsers are Internet Explorer, Netscape, Mozilla, and Opera. 

3.1.3 Web Terms 
You will come across lots of strange words when learning about the internet. Here are some of 
the more important ones: 
 

• http - this is one of the languages used on the internet to help computers to 
communicate, and stands for hyper text transfer protocol. 

 
• ftp - this is a similar language, used for transferring files - it stands for file transfer 

protocol. 
 

• URL (Uniform Resource Locator) - the address of a web site - for example, the URL of 
the BBC's web site is www.bbc.co.uk. 

 
• Hyperlink - how people get around on the web. When you click on a hyperlink, you are 

taken to another page, or a different web site. If you are on a page with no hyperlinks, it's 
not that easy to get somewhere else. 

 
• ISP - Internet Service Provider. To get access to the web, you must pay a fee to an ISP 

who will connect you up. It's a bit like having a telephone - you can buy a phone, but you 
need to pay the telephone company to let you connect to the telephone lines. 
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3.2 Using Help 

3.2.1 Getting Help 
1. Click on the Help menu 
2. Click on Contents and Index 

3.2.2 Contents 
1. Click on the Contents tab 
2. Click on a purple book topic to open it 
3. Click on a topic on the left to read it in the box on the right 

3.2.3 Index 
1. Click on the Index tab 
2. Start typing a word in the search box 
3. Click on a word to display topics about it 
4. Click on a topic to display it 

3.2.4 Closing Help 
Click on the X at the top right of the Help box 
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3.3 Changing the Display 

3.3.1 Showing and Hiding Toolbars 
1. Click on the View menu 
2. Click on the Toolbars submenu 
3. Click on a toolbar name to show or hide it 

 

Is it displayed or hidden? 

If a toolbar has a tick next to it, it is displayed. If it doesn't, it isn't! 
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3.4 Web Addresses 

3.4.1 Typing in Addresses 
1. Click inside the address bar, so that the address goes blue 

 

 
 

2. Press the Delete or Del key 
3. Type in the address of the web site you want to visit 
4. Press Return or click Go 

3.4.2 Back and Forward 
To go back to the previous page you were looking at, click the Back icon 

 
 

To go forward again, click the Forward icon 

 
 
To go back or forward many pages... 
 

1. Click on the arrow next to the Back or Forward icon 
 

 
 

2. Scroll down however many pages you want to go 
3. Click on the page to go back or forward to 



ECDL - Information and Network Services - Getting Started On The Web 

Page 16 SmartTrack  - 0800 358 0 458 

3.4.3 Using the Address Bar 
To go to an address you have previously visited... 
 

1. Click on the drop down arrow on the address bar 
 

 
 

2. Click on the site you want to go to 

3.4.4 Clearing the History 
1. Click on the Tools menu 
2. Click on Internet Options (may just be called Options depending on your browser 

version) 
3. Click Clear History 

 

 
 

4. Click Yes 
5. Click OK 

3.4.5 Web Address Structure 
Taking http://www.bbc.co.uk as an example: 
 
http:// - tells the browser what language to use 
www - world wide web - this part isn't always necessary though 
bbc - company name 
co - this means that it is a public company 
uk - United Kingdom 
 
A body or institution may have .org for organisation, a school would be .edu, and a government 
department will usually have .gov. The country part is flexible - .com can be anywhere in the 
world, really. 
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3.5 Using Links 

3.5.1 Using a Link 
Links are usually blue, underlined text or images. To use a link, just place your mouse pointer 
over it, and click once with the left mouse button. You'll know you are over a link when the 
pointer changes to a pointing hand: 

 

3.5.2 Opening Pages in a New Window 
1. Right click on the link 
2. Click on "Open in New Window" 

 

 

3.5.3 Downloading from a Link 
1. Right click on the link 
2. Click on "Save Target As" 

 

 
 

3. Choose a save location 
4. Click Save 
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3.5.4 Completing a Web Form 
Web forms let you type in information, to log in, or buy things, or sign up for newsletters, and so 
on. There are several types of items in forms: 
 
 
What they are What they look like What to do 
Text boxes 

 
Click inside the box with the mouse, and type something 

Buttons 
 

Click on the button 

Radio buttons 

 

Click inside the circle - only one can be selected at a time 

Check boxes 

 

Click inside the box - many can be selected at a time 
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3.6 Stop and Refresh 

3.6.1 Stop 
To stop a page from loading, click the Stop button 

 

 

3.6.2 Refresh 
To reload (or refresh) a page, click the Refresh button 
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3.7 Web Security 

3.7.1 Cookies 
A cookie is a text file placed on your hard drive by a web site. It is used to keep track of your 
preferences for the site, or to remember your login details to save you logging in every time. 
Cookies should not store sensitive information like bank details, or credit card numbers. 

3.7.2 Cache 
The cache is a store of pages you have visited recently. Internet Explorer keeps these files to 
make your web browsing quicker - but it means people using your machine can see where you 
have been! So don't go looking at anything you shouldn't... 

3.7.3 Protected Web Sites 
A protected web site is one that you log into using a user name and password. This stops people 
seeing your private details. 

3.7.4 Digital Certificates 
A digital certificate is used on a file download or protected web page, so you know if the site is 
safe to download from. Some files with no certificate are safe, but you use them at your own risk. 

3.7.5 Encryption 
Encryption is a code that stops people reading things they shouldn't. An encrypted file has a 
special code applied to it, so if someone tries to read it without the secret code, it will look like 
nonsense. Once you apply the secret code, the file is magically made readable. 

3.7.6 Viruses 
A virus is a nasty program designed to attack your PC or just annoy you. Be very careful when 
downloading files from the internet, always check them with a virus checker before running or 
opening them. If you're not sure about this, ask your IT department to do it for you. 

3.7.7 Credit Card Fraud 
Some web sites will ask for your credit card details, then sell them or use them to buy things 
illegally. Make sure the web site has a gold padlock in the Internet Explorer status bar at the 
bottom - double check that the site is a proper, respectable one before handing over any details. 

3.7.8 Firewalls 
A firewall is a big wall of fire to keep out snakes and tigers. No it isn't, it's a software program that 
stops people sneaking on to your PC when you're connected to the internet. Some people like 
looking out for unprotected machines, so they can poke around and see what's on there. A 
firewall can stop them getting in. 


